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Preface

Thank you for placing your trust in this ELSA product.

With the ELSA MicroLink ISDN 4U, you have chosen a product that will let you set up
local networks and establish connections to the Internet.

Documentation
The accompanying documentation comprises:

® Manual

Hardware installation, description of the functions, operating modes and sample
configurations

® CD containing electronic documentation

This documentation was compiled by several members of our staff from a variety of

departments in order to ensure you the best possible support when using your ELSA
product.

Our online services (Internet server www.elsa.com) are available to you around the clock
should you have any queries regarding the topics discussed in this manual or require any
further support. In the ‘Support' file section under 'Know-How', you can find answers to
frequently asked questions (FAQs). The KnowledgeBase also contains a large pool of
information. Current drivers, firmware, tools and manuals can be downloaded at any
time.

The KnowledgeBase can also be found on the CD. Just open the file \Misc\Sup-
portIISC\ELSASIDE\index.htm.
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Introduction

This chapter will introduce your new hardware and will give you a brief overview over
the performance and features of the ELSA MicroLink ISDN 4U.

The ELSA MicroLink ISDN 4U lets you concentrate on two things: the development of a
network using the integrated hub and the two network cards, as well as access to the
Internet via ISDN. Software wizards simplify the configuration of the unit to help you set
up your ELSA MicroLink ISDN 4U quickly and easily. Thanks to the use of the TCP/IP
protocol, you are not restricted with regard to operating systems. You can use the ELSA
MicroLink ISDN 4U under Windows, on Macintosh computers, under Linux, and with a
BeOS platform.

Networks offer a broad range of options:

® You can double your available hardware resources, as every computer in the
network can access the hardware of the others—hard drives, CD-ROM drives, or
printers.

® You can set up your own intranet.
® You can play your favorite games in multiplayer mode.
® And finally, it's exciting to experience the cooperation of multiple computers.

The ELSA MicroLink ISDN 4U has been tested and fulfills the regulations pertaining to
electromagnetic compatibility (“Declaration of conformity” see Appendix).

Introducing the ELSA MicrolLink ISDN 4U

This section introduces the unit's hardware. [t covers the unit's display elements and
connection options.
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© Power/Info

After switching the ELSA MicroLink ISDN 4U on, the LED briefly lights up. After
about b seconds, it remains lit in red to indicate the operational status of the unit.
If the LED flashes in red, this indicates a boot error.

© ISDN

The ISDN LED shows activity of the ISDN line. The following signals can be
distinguished:

O

O O O O

Red flashing: Incoming call pending

Red steady: Line connection is established

Green flashing: Outgoing call being placed

Green: Protocol negotiation complete

Alternating green/red: Display of sent or received data packets

© LAN link (1-4)

Signal LEDs for the status of the hub ports. The LED is litin green when an Ethernet
10Base-T cable is connected. The LED flickers to indicate activity such as the
transfer of data between computers.
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On/0ff switch
Connection for power supply unit

Ethernet 10Base-T connection for uplinking to further hub units (cascading). Do not
connect a network computer to this socket!

Ethernet 10Base-T network connection (hub)

Reset switch After 3 seconds, the unit will be reset to its factory defaults.

Q00 O00e

ISDN line port

What does the ELSA MicroLink ISDN 4U offer?

The following is an outline of the principal features of the device giving you a quick
overview of its capabilities.

Easy installation

Connect the MicroLink ISDN 4U to the power supply.
Establish a link to the LAN.

Plug in the ISDN cable.

Switch it on.

Go!

LAN connection

The MicroLink ISDN 4U by ELSA functions in Ethernet environments. Use the 10Base-T
connections to connect the MicroLink ISDN 4Uto a 10-Mbit LAN.
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Channel bundling and compression

The device supports static channel bundling via MLPPP and BACP on the ISDN line.

Status displays

A display and LED indicators on the front of your ELSA MicroLink ISDN 4U allow you to
monitor the ISDN and Ethernet connections and the current line connections, thus
simplifying the process of diagnosing any systems failures.

ELSA LANmonitor

When using Windows operating systems, this tool will ensure that status information
pertaining to your router is always visible on your monitor. For each device on the local
network, the most important information is displayed, e.g.:

® Name of the remote station
® Connection duration and transmission rates
® Excerpts of the device statistics (e.g. PPP negotiation data)

Additionally, the software allows you to log and save the messages on the PC for further
processing.
Charge monitoring

Subscribing to “Advice of charge during connection” on the ISDN network (AOCD) allows
you to set the charge units available for a specified period. This puts you in constant
control of your phone hill.

If charge information is not available from your ISDN connection, you can also limit the
active ISDN connect time for a specified period. The router will not permit the
establishment of connections once this time has elapsed.

Compatibility through PPP

The router uses PPP, a widely used protocol, and other protocols to exchange network
data through point-to-point connections with devices made by other manufacturers.
Software update

Your device has a flash ROM memory to ensure that its software remains state of the art.
This allows new firmware to be loaded onto the device without the need to open it up.
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ELSA LANCAPI

The main advantages of using LANCAPI are economic. The LANCAPI s a special type of
CAPI 2.0 interface through which various communications programs (e.g. ELSA-RVS-
COM) via the network can access the router.

Any workstation which has been integrated into the LAN (Local Area Network) can use
LANCAPI to give unlimited access to office communication functions such as fax and
EuroFileTransfer. All functions are made available throughout the network without the
need to add hardware to the workstations. This does away with the cost of equipping
workstations with ISDN adapters or modems. The office communications software
simply needs to be loaded onto the individual workstations.

An ISDN fax device is simulated at the workstation so that faxes can be sent. With the
LANCAPI, the PC forwards the fax via the network to the router which establishes the
connection to the recipient.

DHCP

Thus you can define a certain range of IP addresses which the DHCP server then
independently assigns to the individual devices on the local network.

When in automatic mode, the router can also define all addresses on the network and
assign them to the devices connected to the network.

DNS server

The DNS server functionality lets you create associations between IP addresses and the
names of computers or networks. Requests for known computer names can thus
automatically be assigned to the correct route.

The DNS server can also serve as an effective filter for the users in your local network.
Access to specified domains can be denied to individual computers or complete
networks.
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Installation

This chapter will help you install the network adapters and connect the ELSA
MicroLink ISDN 4U to the individual network computers.

Package contents

Please ensure that the delivery is complete before beginning with the installation. The
package should include the following components:

ELSA MicroLink ISDN 4U

External power adapter

Two network adapters

Two twisted-pair network cables, 5m

ISDN connector cable

Documentation

CD containing ELSA LANconfig, ELSA LANmonitor, ELSA LANCAPI (4-user license),
the ELSA-RVS-COM communications suite and further software

If anything should be missing, please contact your dealer.

Setting up and configuring the network

We will be progressing one step at a time in this section. Please maintain the following
order:

® |Installation of the network adapters
® Connection of the ELSA MicroLink ISDN 4U and cabling of the network
® Configuration under Windows

Installation of the network adapters

An installed network adapter that has been recognized by the operating system is a
precondition for operating a computer in a network.

(@ Briefly touch the computer housing to discharge any static electric charge built up
in your body. Next, disconnect the AC power supply cable from the rear of the PC
housing.

(@ Remove all retaining screws or release the catches for the PC housing and remove
the cover.
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® A free PCI slot is required for the installation of the network adapter. Before
installing the card, remove the blind bracket for the slot you intend to use.

AGP slot

PCl slot

ISA slot

@ Carefully insert the card into the free slot. Ensure that the card is correctly seated
in its slot and tighten the screw of the mounting plate.

If your computer is equipped with an AGP
graphics board, avoid installing the network
adapter in the PCl slot immediately next to the
graphics board if possible. This may lead to an
interrupt conflict between the network adapter
and the AGP graphics board.

(B Replace the computer case and screw it tight.

® Insert the included network cable into the
socket on the bracket of the network
adapter.
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Connect the ELSA MicroLink ISDN 4U

The ELSA MicroLink ISDN 4U is set up for an ISDN Basic Rate Interface. The connection
& is made using the supplied RJ45 cable.

Connecting the Connect the network Onto the Internet via the
9V AC adapter computers to the hub ports of ISDN connection
the MicroLink ISDN 4U

(D First connect the sockets of the network adapters to the hub ports on the back of the
MicroLink ISDN 4U. Use the supplied twisted-pair cables. Please note that only the
sockets numbered 1 to 4 may be used.

@ Insert the flat plug of the AC adapter into the 9V socket of the MicroLink ISDN 4U
and plug the AC adapter into a normal 220V wall socket.

(® Finally, make the connection to the ISDN. Plug the ISDN connector cable into the
ISDN/Sg socket on the back of the MicroLink ISDN 4U, and plug the other end into

the socket of your point-to-multipoint connection (NTBA).
@ Switch the ELSA MicroLink ISDN 4U on.

The unit will initialize and after about 5 seconds, the red LED on the front panel of the
MicroLink ISDN 4U should be lit. The signal lights for the LAN links in use should be lit
green. Your ELSA MicroLink ISDN 4U is now ready for network operation.
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Configuration under Windows

When starting Windows for the first time after installing the network adapter, the
system will recognize the new hardware and prompt you to install the drivers for the
network adapter. Insert the included diskette and edit the path to point to the drivers for
your Windows system (e.g. \ W N98 or \ W N9598).

Next, Windows will prompt you for the Windows installation CD. Please ensure that you
have the Windows CD ready. Insert the CD and enter the correct letter for your CD-ROM
drive and the path.

® Windows 95:\ W N95

® Windows 98: \ W N98

The installation will be complete after a few additional program components have been
copied. Your local network is now ready!

Configuring the ELSA MicroLink ISDN 4U

A variety of methods of accessing the MicroLink ISDN 4U are available when configuring
the unit. We'll use the simplest and most convenient: ELSA LANconfig.

Software installation

The setup program will start automatically as soon as the CD is inserted. If autostart is
disabled on your computer, you can also start the program manually. The program
SETUP.EXE is located in the root folder of the product CD.

Follow the step-by-step installation instructions. Mark the program components

® ELSA [ANconfig and
® ELSA LANmonitor

if you would like to initially set up the MicroLink ISDN 4U for Internet access only. The

® [ELSALANCAPIand
® [ELSA LANCAPI Dial-Up Networking Support

simulate an ISDN adapter card that can be used for office communications applications
such as fax and answering machines. Dial-up Networking Support supports the use of
Windows Dial-Up Networking. This may be necessary, for example, if you would like to
dial into a game server on the Internet; see 'Dial-up networking' on page 19.

The setup program will install the software in the \ Program Fi | es\ ELSAl an
folder. Entries for ELSA LANconfigand ELSA LANmonitorwill be put on the Start Menu.
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ELSA LANconfig

Start the new software with Start » Programs » ELSAlan » ELSA LANconfig.
LANconfigwill search the local network for the MicroLink ISDN 4U. An entry will appear
in the list window as soon as it has been found.

L ELSA LANconfig =l E3

Device Edit Miew Tools Help

ELSA LANconfig searches the local network ~ =2l2us| &l F%(es| @S| 2(c2)
and finds the connected MicroLink ISDN 4U. — addiess alus I

193102232176 Ok

Description

MLISONAL

A number of queries will be made for the configuration of the MicroLink ISDN 4U for its
first use. When you are asked for the IP address and network mask, enter the following
values:

® P address assigned 192.168.0.1
® Network mask 255.255.255.0

Confirm the entries and accept the default settings for the enabled DHCP server. Next,
click on the Finish button to send the values to the MicroLink ISDN 4U.

A setup wizard will now appear to configure your Internet access. This installation is also
dialog-based. If your Internet provider is not listed, select ‘Standard access via PPP'. Be
sure to have the following information ready:

® The number of your Internet service provider (ISP)

@ Your user name and

® Password for Internet access

Once you have entered this information, the setup wizard will take care of the rest and
your MicroLink ISDN 4U will be ready for Internet access.

Restart your system once you are finished.
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The MicrolLink ISDN 4U is ready

You've got to admit it: it was surprisingly easy. Now here's the reward for your efforts.
We will now perform a few tests to check the functionality of the unit in the network and
will establish the connection to your Internet provider.

Network test

Windows contains tools with which simple tests can be performed. If you would like to
check the connection of the ELSA MicroLink ISDN 4U to the sample address, proceed as
follows:

@ Open a window with an MS-DOS prompt.

(@ Enter the following string of commands:

C\>ping -a 192.168.0.1

The program will send four packets to the stated address. You will now be able to see
how the MicroLink ISDN 4U returns an answer line for each packet received.

One way to query the system status is with IS I Y
the program winipcfg.exe. Thistool canalso |
be started in a DOS window, or directly using o e ’% =
Start > Run »> winipcfg. IPAddess [ 19100288171

Subret Mazk ’W

It shows the IP address valid for the current Defaul Gatewiay

network adapter, the network mask (subnet
mask) and the address of the Relegsedll | Renewsll | More o |
MicroLink ISDN 4U(192.168.0.1).

Felease | Remew |

An excursion onto the Internet

To create a connection to the Internet, simply start your Web browser. As soon as you
enter a valid Internet address, the MicroLink ISDN 40U will respond—as you can see from
the LEDs—nhy dialing your ISP. The status bar of your browser will show the files being
loaded from the Internet, and after a short while, the contents of the page will be
displayed. LANmonitor will inform you of the current status of the connection, see
‘Operating modes and functions' on page 29.
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Dial-Up Networking

The ELSA setup program will automatically install all of the required network
components via the 'ELSA LANCAPI Dial-Up Networking Support' option. Dial-Up
Networking connections are required to contact corporate networks or for some game
servers on the Internet that transfer special address information in their protocol.

However, Dial-Up Networking is not installed or not completely installed and set up on
many computers. Please check your installation using the following information and if
necessary supplement your operating system configuration.

Installation of Dial-Up Networking

First check whether Dial-Up Networking is installed in your Windows. Open My
Computer (generally the icon at the very top left of the Windows desktop).

Look for the Dial-Up Networking icon. If this icon is not present, you will have to install
Dial-Up Networking first. You will need your Windows CD for this purpose.

() Open the network configuration dialog with Start » Settings » Control Panel )
Network.

Click on the Add... button to open the network component selection dialog.
Highlight the 'Adapter’ entry and click Add....

Select 'Microsoft' under Manufacturers and 'Dial-Up Networking' under Network
Adapters.

Close all dialogs by clicking on OK.

©@©@ ® e 6

After the required files have been copied, it will be necessary to restart the
computer.

If the required files are not found on the main folder of the CD, try to find them in the
D:\wing8 or D:\windows subfolders. Alternatively, the key combination + D will
open a search window for searching the CD.

You may also find the files in a subfolder of the Windows folder on your hard drive, e.g.
in ‘c:\windows\options\cabs'

Dial-Up Networking is then installed and the corresponding item will appear in ‘My
Computer'.
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Create new connection

(@ Double-click in My Computer, Dial-Up Networking on Make New Connection.

_ (@ Enter a name for the connection in the next window and select 'ELSA LANCAPI -
Connection Line1'. To enter the phone numbers go on to the next window by clicking the Next
button.

(® Enter the area code and the phone number of your Internet provider and if required
select a different country code. Selecting Finish in the following window
establishes the new connection.
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The ELSA MicroLink ISDN 4U as a hub

This section will show you the options which the ELSA MicroLink ISDN 4U has to offer
as a hub in a Windows network environment.

Our example will assume that a simple network is being set up, i.e. without a server and
its specific services.

Shared resources

The sharing of resources is a significant advantage of networks. The available
possibilities and their implementation will be covered in this section. This includes the
sharing of

® printers,

® harddrives and CD drives

All of the options for the configuration of network operations under Windows can be
found under the Network dialog. This can be accessed via

Start > Settings > Control Panel » Network

Metwork HE
Configuration | |dentific:ation | Access Control |
. . The follawing network components are installed:
The Network d|a|0g Under WmeWS: Client for Microzoft Metworks
the Centl’a| |Ocati0n for a| | ne‘[WOI’k SettingS SEQ_m EtherLink 111 154 [3C509/3C509b] in 154 mode
DFU-Adapter

TCPAP -» 3Com EtherLink I11 154 [3C503/3C5090] in 154 mo
TCRAP - DFL-&dapter

Ll | »]

Add e | [ETE— |

Primary Metwark Logan:

ICIient for Microsoft Metworks j
Eile and Print Sharing... |
Description
ok | Cancel |

Perform the following steps:

® Add a shared service
® |dentify the computer
® Specify the access control
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Set up the shared service

The sharing service must be set up under Windows in order to transparently display the
hardware of other computers in the network:

(@ In the 'Configuration’ dialog box, click on Add.
(@ Select the network component 'Service', and once again click on Add.

® Select the network service 'File and printer sharing for Microsoft networks'.

The following network components are installed:

Client for Micrasoft Metworks

B2 3Com EtherLink |Il 154 [30509/3C5090) in 154 mode
4~ TCRAP

1B File and printer sharing for Microsoft Metworks

The new service will be entered in the list of
network components.

At the same time, the File and Printer
Sharing button will be enabled.

Add... Eemayve Eroperties |

Frimary Metwork Logon:
Client for Microsoft Metwaorks j

@ Confirm the settings by clicking OK.

® Click on the File and Printer Sharing... button and in the following window, mark
the two options that control file and printer access.

The sharing service is now ready.

Give your computer a name

The Network dialog contains the 'ldentifica-  [rm K
tion' tab. Here you can give your computer a Configation Identfieation | Access Corirl|
name and Sp@ley the WOfkngUp tO Wthh |t E ‘Windows uzes the fallowing information to identify pour

=4 computer on the network. Please type a name for this

computer, the warkgroup it will appear in, and a shart
deszcription of the computer,

The name you enter here will then appear in Computername: [fubdierst
the Network Neighborhood of the other R
computers.

should belong.

gm“"“‘e' . [P 300with COROM
escription:
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Granting access rights

The granting of access rights can be taken | [(EEC S|
care of quickly. Two options to control the Cortfguaion| Idenilcaon ccess Corrl |

type of access can be found on the "Access [ Dokl access 1o shared fesoutces sig:

Control' tab. At this point we are assuming i o e s o e s

that your network does not use a server and —

that you are setting up a pure Windows 9x Encbisyu o spciy s andgoups whe e
network. In this case mark the 'Share-level btain i o users and groups from

access control' option. This will permit all

computers in the network to access all drives
and folders.

This concludes all of the entries and configuration required for TCP/IP network operation.
Repeat these four steps for each computer that you would like to integrate in the
network.

Resource sharing

Sharing drives

The simplest way to share drives and printers is via the Windows Explorer. All available
drives are listed in the left window of the Explorer. Right-click on the drive that you
would like to share.

@ In the pop-up menu, select Sharing....
@ Select 'Shared As:' and enter a name for the drive.

(® Finally, determine how access will take place: whether only reading or also writing
rights will be available, and whether these should be secured with a password.

@ Confirm the settings by clicking OK. A hand will appear under the drive icon in the
Explorer to indicate the shared status of the drive.

The sharing of drives is now complete.

If you would like to restrict access, you can also apply this process to individual folders.
Please note that all subfolders of the shared folder are automatically also shared.
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Sharing printers
() To share a printer, select
Start > Settings > Printers

(@ The window that now appears contains all of the printers installed on the system.
Highlight the printer you would like to share and select File » Sharing...

(® The dialog box that you already know from drive sharing will now reappear. Make
the necessary entries and confirm with OK.

The sharing of printers is now complete.

Fun and games in the network

Once you've found your opponents for multiplayer sessions in the LAN, the
MicroLink ISDN 4U will be extremely cooperative.

All you need to do is to ensure that the network adapters of the computers are connected
to the hub ports, and start your game. The settings for network operation are normally
handled by the game itself. The multiplayer mode should contain a menu with the option
of starting a server and clients. Once a server has been started, a client query will search
the network and recognize the server via TCP/IP. The client will then be able to log into
the game.
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Configuration modes

The ELSA MicroLink ISDN 4U is always dispatched with up-to-date software in which
several of the settings have already been made.

It will nevertheless be necessary for you to add some information and configure them to
your specific needs. These settings are made as part of the configuration process.

This section will show you the programs and routes you can use to access the device and
set it up.

And, if the team at ELSA has produced new firmware with new features for your use, we
will show you how to load the new software.

Preconditions

TCP/IP or TFTP are used to make configurations using Telnet or ELSA LANconfig. This
means that the TCP/IP protocol must be installed on the computer being used and the
router must be given an IP address which you will then use when addressing it.

A device that has not been configured yet will respond to the IP address
XXX XXX.XXX.254, in which the Xs are placeholders for the network address in your LAN.
If the computers on your network have addresses such as 192.168.130.1, then you will
be able to address the device using 192.168.130.254.

Configuration using ELSA LANconfig

Call up the configuration tool ELSA LANconfig from the Windows Start Menu, for

example, with Start » Programs > ELSAlan - ELSA LANconfig. ELSA [ANconfig
searches the local area network for devices.

Just click on the Browse button or call up the command with Device P Find to initiate
a search for a new device manually. ELSA LANconfig will then prompt for a location to
search. You will only need to specify the local area network if using the inband solution,
and then you're off.
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Once ELSA LANconfig has finished its search, it displays a list of all the devices it has
found, together with their names and, perhaps a description, the IP address and its

status.
B ELSA LANCconfig =]

Device Edit “iew Toolz Help

Sl Slp) ol alsiel i)

| D escription | Address | Status
193.103.233.254 Ol

Glazgow Ver 0,92 [28.07.93) SM. 8223.000.260

Two display options are available for the configuration of the devices using ELSA
LANconfig:.

® The 'simple display’ mode only shows the settings required under normal
circumstances.

® The ‘complete display’ mode shows all available configuration options. Some of
these settings should only be modified by experienced users.

Select the display mode with the View > Options menu.

Double-clicking the entry for the highlighted device and then clicking the Configure
button or the Edit »- Edit Configuration File option reads the device's current settings
and displays the ‘General configuration selection.

The remainder of the program's operation is pretty much self-explanatory or you can use
the online help. You can click on the question mark top right in any window or right-click
on an unclear term at any time to call up context-sensitive help.

Configuration using Telnet

Start inband configuration using telnet with the command from a DOS box:
Tel net 10. 1. 80. 125
Telnet will then establish a connection with the device using the IP address.

After the entry of the password (if you specified one to protect the settings) all
commands from the 'Configuration Commands' section are available.
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Configuration commands

Commands and path specifications are entered using the normal DOS or UNIX
conventions if you are using telnet or a terminal program to configure the device.

Enter a forward slash or backslash to separate the path specifications. You do not need
to write out commands and table entries in full; an unambiguous abbreviation will do.

The entries for the categories MENU, VALUE, TABLE, TABINFO, ACTION and INFO will
be displayed during the configuration and may be modified. You can use the following

commands to do this:

7 or help calls up help text.
dir, list, Il, Is <MENU>, displays the contents of MENU, | dir/status/wan-statistics displays the
<VALUE> or <TABLE> VALUE or TABLE. current WAN statistics.
cd <MENU> or <TABLE> | switches to the MENU or TABLE | cd setup/internet-module (or cd se/in
specified. for short) switches to the internet
module.
set <VALUE> this resets the value. setIP-address 192.110.120.140 sets a
new IP address.
insert a space between all set /setup/name AACHEN assigns
entries in table rows. An * the name 'AACHEN' to the device.
leaves the entry unchanged.
set <VALUE>? shows you which values can be
specified here.
del <VALUE> deletes a a table row. del /se/in/lan/AACHEN

deletes the entry for the remote sta-
tion AACHEN.

do <ACTION> (parame-
ters)

executes the ACTION according
to any parameters specified.

do /firmware/firmware-upload starts
the upload of new firmware.

passwd

allows a new password to be
specified. The old password, if
there is one, must be entered
first. The new password must
then be entered twice in a row
and confirmed each time with
=3}

repeat <sec> <ACTION>

repeats the action at an interval
of the number of seconds speci-

fied. Any key can be used to ter-

minate the repetition.

repeat 3 dir/status/wan-statistics
displays the current WAN statistics
every 3 seconds.

time

sets the system time and date.

time 24.12.1998 18:00:00

language <Language>

sets the language for the current
configuration session.

Languages currently supported:
English (language English)
German (language Deutsch)

exit, quit, x

configuration is terminated.
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Text entries (individual and table values) can be deleted as follows:

set /se/snnp/adm n
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Operating modes and functions

In this chapter we will be covering the configuration options provided by ELSA LANconfig
and the monitoring functions available using ELSA LANmonitor.

ELSA LANconfig

ELSA [ANconfig is a convenient administration tool. With it, all of the settings of the
ELSA MicroLink ISDN 4U can easily be checked and changed as required.

The sections are organized according to the 4 configuration modules and their menu
structure. The headers marked with an asterisk (*) mark dialogs that are only available
when the complete configuration is displayed.

The ELSA LANconfig online help contains a context-sensitive explanation for each menu
item and dialog field.

Management

General

Here is where you assign a name to your MicroLink ISDN 4U and can obtain detailed
information regarding the type of unit and its firmware.

Security

The simplest option for the protection of the configuration is the establishment of a
password. As long as a password hasn't been set, anyone can change the configuration
of the device.

Charge

The capability of the router to automatically establish connections to all required remote
stations and close them again when no longer required provides users with extremely
convenient access (e.g. to the Internet). However, incorrect configuration of the router
(such as badly configured filters) for data transfer via or excessive use of the features
provided (continual Internet surfing, for example) via lines subject to connect charges can
result in high charges.

The software offers a variety of options to limit costs:

® Charge-based ISDN connection limits

If charge information is available from your ISDN connection, connection charges
can be limited quite easily. For example, in its default state, a maximum of 830
charge units may be used per six days. The router will not permit the establishment
of any further connections once this limit has been reached.
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The best way to use the router's call charge monitoring function is if you have “call
charge information enabled during the connection” to the ISDN network (i.e. AOCD). If
necessary, subscribe to this facility from your telecommunications carrier. Charge
monitoring with the “Charge information after connection” feature is also possible in
principle, but in this case continuous connections may not be detected!

® Time-dependent ISDN Connection control

The maximum duration of connections can also be limited if your ISDN connection
does not provide connect-charge information. This requires setting up a time budget
for a specified period. In the router's default state, for example, connections may
only be established for a maximum of 210 minutes per six days.

When the limit of a budget is reached, all open connections that were initiated by the
router itself will be shut down automatically. The budgets will not be reset to permit the
establishment of connections until the current period has elapsed. Needless to say, the
administrator can reset the budgets at any time if required!

The charge and time monitoring of the router functions can be disabled by entering a
budget of 0 units or 0 minutes.

Only the router functions are protected by the charge and time monitoring functions!
Connections via LANCAPI are not affected.

Internet

General

Enter the number of your Internet service provider (ISP) here. Determine the period of
inactivity after which the call should be ended automatically. The default value is
60 seconds.

The user name and password must be entered to log in with your provider.

Options*
® Channel bundling

Activating channel bundling opens both B channels anytime a connection is
established, permitting data transfer—provided the remote station supports it—at
theoretically double the usual speed. Both ISDN channels are thus in use, also
resulting in twice the usual connect charges.

® Protocol settings

Most Internet service providers (ISP) can be reached using the default PPP
connection. In some cases it may be necessary to select a different protocol,
however. In the event that you cannot establish a connection using the default
settings, please contact your ISP.
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Security

A number of the access controls relevant to security in the local network and Internet can
be placed in this dialog window.

® Blocked Internet addresses

If you would like to block access to certain Internet addresses, enter their names or
IP addresses here.

® Filter packets™

Packet filtering requires detailed knowledge of protocol negotiations and port
addresses. If you would like to filter data packets being transferred over specific
port addresses, define the appropriate source and target ports in the tables. This
option is available for external network dialogs and the local network.

Advanced*®

The manual configuration of the IP address is only necessary if your ISP does not assign
this address automatically. This is very rare, however, and your ISP can provide all of the
necessary information in such a case.

The masking of the local network is set by default. It is only necessary to change this
setting if you have been assigned more than one IP address by your ISP. In that case,
assign the addresses to the computers in your network as permanent IP addresses. The
computers “behind” the MicroLink ISDN 4U are then no longer hidden, however, and will
be visible to other Internet users.

The lower group field offers the option of changing the hold times for a variety of common
protocols (TCP, UDP and ICMP). You should keep these default settings under normal
circumstances. You may want to increase these values, however, if you are experiencing
difficulties in establishing a connection or in the event of frequently dropped
connections. Please note that the hold time for the ISDN connection must always exceed
the hold times for the protocols!

Local network

General

Use this tab to set the intranet address, network mask and domain name. These settings
only apply to your local network.

The TCP/IP protocol used for the actual communication between the MicroLink ISDN 4U
and the remote stations is standardized for the exchange of data in networks. That also
applies to the transfer of data on the Internet. After all, IP stands for Internet Protocol.

Each computer needs an IP address to participate in the network dialog; this permits it to
be identified clearly for the precisely targeted transfer of data. The IP address consists
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of four numbers separated by dots (e.g. 192.168.100.1). Each of these numbers can be
between 0 and 255.

A number of address ranges exist, known as classes. These classes can be used for a
variety of purposes. Three address classes have been defined for private networks which
are never assigned in public networks.

Class A-address 10.X.X.X
Class B-address 172.16.x.x
Class C-address 192.168.x.x

Computers that have been assigned addresses from these ranges are not visible on the
Internet.

The address 127.0.0.1 is an exception. It is used to check the local computer and may
A not be assigned.

DHCP

Activating the DHCP server is recommended in most cases for private local networks.
This eliminates the need to set up the workstations — assigning IP addresses and suitable
network masks. The DHCP server should thus be activated under normal circumstances.

The address ranges to be assigned may be restricted. Enter the starting and end
addresses of the desired range, e.g. 192.168.0.10 and 192.168.0.100 in the appropriate
fields.

Advanced*®

Changes in the validity addresses for DNS queries and DHCP addresses are normally not
required. The default values should only be changed if you have more computers than
IP addresses in your network, for example. In such a case, lower the maximum validity.
This releases unused IP addresses.

LANCAPI

General

ELSA LANCAPI is a port that simulates an ISDN card and controls the dialog with
communications programs such as ELSA-RVS-COM. This item must be enabled in the
ELSA Setup during the software installation to ensure that you will have access to the
CAPI.
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First, establish how the LANCAPI server should respond. Next, specify the MSNs to
which the LANCAPI should respond. Individual numbers can be dedicated for telephone
and fax services in ELSA-RVS-COM, for example. If you enter exactly these numbers, the
LANCAPI will only respond to calls and faxes, provided that these have been correctly
addressed by the sender.

ELSA LANmonitor

The monitoring tool ELSA LANmonitor can be used to display the most important
information about the status of your router on your monitor at all times. Many of the
internal messages generated by the device are converted to plain text, thereby helping
you to troubleshoot.

The ELSA LANmonitor online help contains a context-sensitive explanation for each
menu item and dialog field.

Installing ELSA LANmonitor

Usually, ELSA LANmonitor is automatically installed together with the ELSA LANconfig
configuration software on the computer from which you wish to configure your router.

If ELSA LANmonitor is not yet installed on your computer, place the ELSA Microlink
ISDN 4U CD in your CD drive. If the setup program does not start up automatically after
insertion of the CD, start Windows Explorer, click on ‘autorun.exe’ on the CD and follow
the instructions in the install program.

During the installation you should activate the LANmonitor option.

Checking your internet connection with ELSA LANmonitor

To demonstrate the functions of ELSA LANmonitor we will first show you the types of
information ELSA LANmonitor provides about connections being established to your
Internet provider.

@ So you should setup ELSA MicroLink ISDN 4U to connect to your provider, e.g. with
the ELSA LANconfig setup wizard. We selected call-by-call access to Arcor for this
example.

(@ Start up ELSA LANmonitor by clicking Start » Programs » ELSAlan )
LANmonitor. Generate a new device by selecting Device » New and, in the
following window, enter the IP address of the router you wish to monitor. If the
configuration of the device is protected by password, enter the password too.

Alternatively, you can select the device in the ELSA LANconfig and monitor it using
Options » Monitor Device.
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® ELSA LANmonitor automatically creates a new entry in the device list and initially
displays the status of the B channels. Start your Internet browser and enter any web
page you like. You can now see in ELSA LANmonitora connection being established
on one channel and the name of the remote site being called. As soon as the
connection is established, a plus sign against the B channel entry indicates that
further information on this channel is available. Click on the plus sign to open a tree
structure in which you can view various information.

I [=1 E3

Device Yiew Help
Y LALHEN]
-G Line 1: Connected ta PROVIDER
=% Protocal: PPP

T IP address: 62,144 255,145
- Mame server 195.185.185.195

In this example, you can determine from the PPP protocol information the IP address
assigned to your router by the provider for the duration of the connection and the
addresses transmitted for the DNS and NBNS server.

Under the general information you can watch the transmission rates at which data
is currently being exchanged with the Internet.

@ To break the connection manually, click on the active channel with the right mouse
button.

® If you would like a log of the ELSA LANmonitor output in file form, select 'Options'
from the 'View' menu and go to the ‘'Log' tab. Enable logging and specify whether
ELSA LANmonitor should create a log file daily, monthly, or on an ongoing basis.
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Office communications

ELSA-RVS-COM

What does ELSA-RVS-COM offer?

ELSA-RVS-COM is a powerful, universal communications program which provides you
with the most important data communications applications in a convenient, easy-to-use
package.

ELSA-RVS-COM offers the following options in combination with your ISDN modem:

Fax

® Faxgroup 3 and 4 via software

® fFaxoperation at up to 64,000 bps

® Faxtransmission from Windows applications via a Windows printer driver
® Delayed fax transmission

® Faxpolling

File transfer

® Softmodem functionality
® Convenient PC-to-PC file transfer
® CEuroFileTransfer with Explorer-compatible user interface

Telephone and answering machine

® Full ISDN telephony features (in conjunction with a full-duplex sound card)
® Digital answering machine (requires sound card)

Virtual COM ports

® Virtual COM ports enable employment of traditional data communications software

CommCenter

@® Universal receive status with CommCenter
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Setup for ELSA-RVS-COM

The setup program for ELSA-RVS-COM copies the required files to the selected drive and
creates a program group on your Windows desktop.

System requirements

The following minimum requirements must be fulfilled for the use of ELSA-RVS-COM:

Operating system Microsoft Windows 95, Windows 98 or Windows NT 4.0
(USB devices Windows 98 only)
CPU fully compatible with Pentium or higher
RAM min. 16 MB; min. 32 MB for fax mode
Disk space min. 25 MB free memory space before installation
min. 12 MB during operation for virtual main memory (swap file)
Graphics board aminimum of VGA (640 x 480 pixels, 16 colors/shades of gray)
256 colors min. for Btx/Videotext
Other sound card and microphone for answering machine and telephony

Follow the steps below to install ELSA-RVS-COM:

@ Start Windows. When installing under Windows NT, ensure beforehand that you
have administrative privileges.

@ Insert the CD in the CD-ROM drive (e.g. D:\) The CD setup will start automatically. If
the setup program does not start automatically, double-click ‘autorun.exe' on the
CD.

(® Start the installation by clicking on ELSA-RVS-COM in the welcome screen
selection. The serial number entry window will appear.

@ In the KEY field, enter the ELSA-RVS-COM serial number on the enclosed serial
number sticker (please note that the number is case-sensitive) and click Next. The
welcome screen appears.

(3 Read the displayed notes and press Next. The target folder selection window will
be displayed after the license agreement. Please read the following notes and click
the Next button. Please read the license agreement and confirm your agreement
by clicking the Yes button. When installing under Windows NT 4.0, acknowledge
the Windows NT information with the Next button. The 'Installation Folder' dialog
box will appear.

(® Accept the proposed target folder or enter the path and the name of the folder in
which you want to install the program. Then click Next. Now the program files will
be copied.

@ Now setup is terminated. Click on Finish to start the installation wizard.
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The Installation wizard for ELSA-RVS-COM

The installation wizard will support you in configuring the services you require such as
fax and answering machine functions and in entering the subscriber number of your ISDN
line. Afterwards you are able to start communicating immediately.

® With the 'Standard configuration’, you can set up a fully functional ISDN system
while supplying very little required information. For example, you only need to enter
a calling number, without having to assign the numbers to services such as fax,
answering machine, etc.

® The 'Customized configuration' is only required if you have specific configuration
requirements (e.g. different numbers for fax, EFT, etc.). You can then enter various
numbers and assign individual functions.

You may also call the wizard later at any time to modify or enhance the configuration.

ELSA-RVS-COM has its own 'Inbox' for managing fax and voice messages. No Microsoft
Exchange or Outlook components are required if you do not expressly activate this option
when setting up ELSA-RVS-COM using the 'Customized Installation’.

The following paragraphs will describe some important configuration items for the
various operating systems.

If you experience difficulties when configuring ELSA-RVS-COM, support and further
information is available at all times using the comprehensive ELSA-RVS-COM help
function.

Entering the subscriber numbers

During the 'Customized installation’, you will be prompted for your ISDN line's subscriber
number(s). There are different dialog windows for the various ISDN systems, for
example Euro ISDN and 1TR6, the German national ISDN.
® Euro ISDN connection
Fora Euro ISDN line you will normally enter the subscriber numbers of your line as
MSN1, MSN2 and MSN3 (Multiple Subscriber Numbers).

The central number and extensions are entered separately for private branch
exchanges. If necessary, find out about your ISDN port’s special features.

Start ELSA-RVS-COM

After the installation is complete, the new ELSA-RVS-COM program folder is
automatically displayed and the RVS CommCenter starts up. Click on the status
indicator to open the program folder.

In the Start menu, select Start » Programs » ELSA-RVS-COM, and click on the
component that you would like to start.
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Appendix

Technical data

Functions ISDN IP router and 4-port hub
LAN connection Ethernet IEEE 802.3; 10Base-T (Twisted PairRJ45, Uplink/Hub)
Network protocols [P TCP, ICMP, ARP. RIP-1, RIP-2, PROXY ARP. DHCP, DNS, NetBIOS/IP

1 target network, up to 4 local stations

Filter concept (UPD/IDP port include/exclude, IP address include/exclude)
Firewall and filter concept (filtering of packets on the WAN side)

ARP protocol: up to 4 local stations

IP address assignment from the remote station

IP assignment to terminal devices in the network (DHCP server, static and
dynamic), up to 4 local assignments

NetBIOS filtering for the suppression of connections in internal Windows
network operations

ISDN interface Connect: ISDN Sy bus, point-to-point-multipoint configuration, 1.430

D-channel: Euro ISDN (DSST1)
B-channel: PPP (RFC 1661), asynch. PPP, X.75, HDLC, CAPI 2.0 over ELSA

LANCAPI
Line control Short hold mode, Line-on-Demand
Charge monitoring Restrictions via connect-charge and time budgets
Security and firewall Address filter for IP, protection of the configuration via access lists and
functions passwords, logging of recent connection information
IP masquerading Internet access using a single IP address via IP address and port
(NAT/PAT) implementation; static/dynamic IP address assignment via PPP. masking

of TCP, UDP. ICMP and FTP; DNS forwarding; Internet access via standard
Internet service providers or CompuServe

Management Via the LAN with TCP/IP, password protection, TFTP configuration, £LSA
LANCconfig, ELSA LANmonitor

Operating security Hardware watchdogs, regular self-testing

Statistics lf'AN and WAN packet counters; error, connection and charge counters,
imer

Power supply 9V AC with AC adapter for 230V, 18VA

Ambient conditions Temperature: 5 - 40°C, humidity: 0 - 80%, non-condensing

Type Dtestigner housing; connections on rear; LEDs for LAN, WAN and Hub
status
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Declaration of conformity

C€

KONFORMITATSERKLARUNG

DECLARATION OF CONFORMITY

Diese Erkldrung gilt fiir folgendes Erzeugnis:
This declaration is valid for the following product:

Geriteart: ISDN Router
Type of Device:
Typenbezeichnung: ELSA MicrolLink ISDN 4U

Product Name:

EG-Baumusterpriifbescheinigungs Nr.: D810576L

Registration No.:
Benannte Stelle: CETECOM ICT Services GmbH
Notified Body: C€0682 X

Hiermit wird bestétigt, daB das Erzeugnis den folgenden Schutzanforderungen entspricht:
This is to confirm that this product meets all essential protection requirements relating to the

Niederspannungs Richtlinie (73/23/EWG)
Low Voltage Directive (73/23/EEC)

EMV Richtlinie (89/336/EWG)

EMC Directive (89/336/EEC)

ISDN Vorschrift (98/515/EG)
Council Decision (98/515/EC)

Zur Beurteilung der Konformitdt wurden folgende Normen herangezogen:
The assessment of this product has been based on the following standards

EN 50082-1: 1992 Teile / parts : EN 61000-4-2, 3, 4, 5, 6

EN 50081-1: 1992 Teil / part : EN 55022B: 1994

EN 60950: 1992 +A1: 1993 +A2: 1993 +A3: 1995 +A4: 1997
TBR3

Diese Erklarung wird verantwortlich fiir den Hersteller / Importeur:
On behalf of the manufacturer / importer:

ELSA AG
Sonnenweg 11
D-52070 Aachen

abgegeben durch: / this declaration is submitted by:

L BT I
Joi 11 é’/
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Warranty conditions

The ELSA AG warranty, valid as of June 01, 1998, is given to purchasers of ELSA products in addition to
the warranty conditions provided by law and in accordance with the following conditions:

1  Warranty coverage

a)  The warranty covers the equipment delivered and all its parts. Parts will, at our sole discretion, be
replaced or repaired free of charge if, despite proven proper handling and adherence to the
operating instructions, these parts became defective due to fabrication and/or material defects.
Also we reserve the right to replace the defective product by a successor product or repay the
original purchase price to the buyer in exchange to the defective product. Operating manuals and
possibly supplied software are excluded from the warranty.

b)  Material and service charges shall be covered by us, but not shipping and handling costs involved
in transport from the buyer to the service station and/or to us.

¢) Replaced parts become property of ELSA.

d)  ELSA are authorized to carry out technical changes (e.g. firmware updates) beyond repair and
replacement of defective parts in order to bring the equipment up to the current technical state.
This does not result in any additional charge for the customer. A legal claim to this service does
not exist.

2  Warranty period

The warranty period for ELSA products is six years. Excepted from this warranty period are ELSA color
monitors and ELSA videoconferencing systems with a warranty period of 3 years. This period begins at
the day of delivery from the ELSA dealer. Warranty services do not result in an extension of the warranty
period nor do they initiate a new warranty period. The warranty period for installed replacement parts
ends with the warranty period of the device as a whole.

3  Warranty procedure

a)  If defects appear during the warranty period, the warranty claims must be made immediately, at
the latest within a period of 7 days.

b)  Inthe case of any externally visible damage arising from transport (e.g. damage to the housing), the
transport company representative and ELSA should be informed immediately. On discovery of
damage which is not externally visible, the transport company and ELSA are to be immediately
informed in writing, at the latest within 7 days of delivery.

¢)  Transport to and from the location where the warranty claim is accepted and/or the repaired device
is exchanged, is at the purchaser's own risk and cost.

d)  Warranty claims are only valid if the original purchase receipt is returned with the device.

4  Suspension of the warranty

All warranty claims will be deemed invalid

a) if the device is damaged or destroyed as a result of acts of nature or by environmental influences
(moisture, electric shock, dust, etc.),

b) if the device was stored or operated under conditions not in compliance with the technical
specifications,
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c)

d)
e)
f)

9)
h)

5

if the damage occurred due to incorrect handling, especially to non-observance of the system
description and the operating instructions,

if the device was opened, repaired or modified by persons not autharized by ELSA,
if the device shows any kind of mechanical damage,

if in the case of an ELSA Monitor, damage to the cathode ray tube (CRT) has been caused especially
by mechanical load (e.g. from shock to the pitch mask assembly or damage to the glass tube), by
strong magnetic fields near the CRT (colored dots on the screen), or through the permanent display
of an unchanging image (phosphor burnt),

if, and in as far as, the luminance of the TFT panel backlighting gradually decreases with time, or

if the warranty claim has not been reported in accordance with 3a) or 3b).

Operating mistakes

If it becomes apparent that the reported malfunction of the device has been caused by unsuitable
software, hardware, installation or operation, ELSA reserves the right to charge the purchaser for the
resulting testing costs.

6
a)
b)

c)
d)

e)

f)
9)

h)

Additional regulations

The above conditions define the complete scope of ELSA's legal liability.

The warranty gives no entitlement to additional claims, such as any refund in full or in part.
Compensation claims, regardless of the legal basis, are excluded. This does not apply if e.g. injury
to persons or damage to private property are specifically covered by the product liability law, or in
cases of intentional act or culpable negligence.

Claims for compensation of lost profits, indirect or consequential detriments, are excluded.
ELSA is not liable for lost data or retrieval of lost data in cases of slight and ordinary negligence.

In the case that the intentional or culpable negligence of ELSA employees has caused a loss of data,
ELSA will be liable for those costs typical to the recovery of data where periodic security data back-
ups have been made.

The warranty is valid only for the first purchaser and is not transferable.

The court of jurisdiction is located in Aachen, Germany in the case that the purchaser is a merchant.
If the purchaser does not have a court of jurisdiction in the Federal Republic of Germany or if he
moves his domicile out of Germany after conclusion of the contract, ELSA’s court of jurisdiction
applies. This is also applicable if the purchaser's domicile is not known at the time of institution of
proceedings.

The law of the Federal Republic of Germany is applicable. The UN commercial law does not apply
to dealings between ELSA and the purchaser.
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